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Introduction 
Size exclusion chromatography with multi-angle static light scattering (SEC-MALS) is used to measure 
macromolecular mass in solution.  Size-exclusion chromatography (SEC) separates molecules based on 
hydrodynamic volume Mass estimate from SEC depend on similarity in shape to a set of reference 
standards for accurate mass determination and fail for elongated or sticky proteins.  Multi-Angle Light 
Scattering (MALS) is used to accurately measure the intensity of scattered light. Light scattering intensity 
is proportional to weight-averaged molar mass in solution. Combining SEC, MALS and concentration 
detectors in an SEC-MALS experiment allows for more accurate mass measurements that SEC or MALS 
alone.  MALS can also be used to determine oligomeric state and polydispersity of macromolecular 
samples. 

 
 
Dynamic Light Scattering (DLS) measures the time-dependent fluctuations in scattered light. These 
fluctuations are directly related to rate of diffusion of the molecule through the solvent, and can be used 
to measure hydrodynamic radius (Rh) of the particles in solution. Peaks that separate by SEC but that 
have the same mass will have different shapes and Rh. 
 
Protein Conjugate Analysis. By using two concentration detectors (RI and UV), the molar mass and 
weight-fraction of a modifier can be determined. This can be used to measure protein and modifier 
masses of integral membrane proteins in detergent micelles and of glycosylated proteins. See the CMI 
Guide to Protein Conjugate Analysis for more information and protocols. 
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 Instrument Overview  
The CMI has a SEC-MALS system with light scattering detectors and refractive index (RI) detector from 
Wyatt and liquid chromatography system and UV detector from Agilent.  There is no fraction collector 
on this system, as it is intended for analytical chromatography. The CMI also has a Wyatt DynaPro Plate 
reader III for batch dynamic and static light scattering in microplates. 
 
MALS 

• Wyatt Dawn Heleos II Multi-Angle Light Scattering (MALS) detector 
• Wyatt Optilab T-rEX Refractive Index Detector 
• Wyatt In-line QELS detector for Dynamic Light Scattering 

Chromatography 
• Agilent 1260 Infinity Isocratic Liquid Chromatography System 
• Agilent 1260 Infinity Autosampler 
• Agilent variable wavelength UV detector 
• Inline solvent degasser 

 
Applications 

• Weight-averaged molar mass  (Mw) of particles separable by SEC 
• Oligomerization state 
• Mass contribution from two components 

o Protein and detergent micelle 
o Protein and glycan 

• Radius of hydration (Rh) 
• RMS radius (Rg) for large particles (> 10 nm) 

Key Features 
• 18-angle Dawn Heleos static light scattering detector for mass measurements for a wide size 

range and Rg measurements 
• UV and RI detectors for concentration measurements in two orthogonal ways.  

o Allows for deconvolution of mass contribution of two components. 
• In-line DLS detector for Rh measurements of particles for which Rg cannot be determined. 
• 100 sample autosampler for minimal protein loss and automated data collection. 

Required Supplies 
• Sample filters, 0.02-0.2 μm filters (recommended) 
• Autosampler vials (provided by the CMI) 
• Analytical SEC Column: 

o A range of analytical SEC columns can be used including silica and agarose columns 
o silica columns (e.g. SEPAX SRT SEC-300, 7.8 mm x 300 mm) 

§ generally excellent performance 
§ low shedding 
§ maximum pH of 7.5  

o agarose columns (e.g. Superdex 200 Increase 3.2 x 300mm) 
§ more shedding, requires longer equilibration times 
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 § wide pH range 

o The CMI usually has 2-3 working SEC-MALS columns that users may borrow, if their 
samples are purified by SEC and in an appropriate buffer (pH ≤ 7.5, salt > 100 mM). No 
guarantees on performance are offered.  

o Make sure that the column is compatible with your sample. Some detergents and 
membrane proteins will require special columns designed for hydrophobic samples and 
buffers. 

Sample Preparation 
 
Assay Buffers 
Running buffer should always be chosen to be compatible with both the SEC column and the protein 
sample. Make sure you know the buffer compatibility of the SEC column you are using. 

• Prepare sufficient buffer (1L is recommended) 
• Recommended Buffer: PBS or HBS (25 mM HEPES pH 7-7.5, 150 mM NaCl), filtered. 
• Most silica columns will not tolerate pH above 7.5. 
• Some buffer components (e.g. glycerol) will require customization of the solvent profile. Take 

note of the absolute refractive index of the solvent after equilibration and before data 
collection. 

Samples 
• It is good practice to run a size-exclusion chromatography purification prior to analytical SEC-

MALS to buffer exchange and clear aggregates. This is a requirement if you are using a shared 
CMI column. 

o The sample should be prepared in running buffer to minimize RI peak due to sample 
solvent. This is particularly important for samples that run near the solvent peak. 

• Know the UV extinction coefficient (in ml/mg•cm) and concentration (in mg/ml) of your protein. 
o Concentration should be accurately measured to assess column recovery. 

• Filter or centrifuge samples before use. 
o Protein aggregates can damage the column. 

• Assess protein heterogeneity via dynamic light scattering (in the DynaPro plate reader). 
• Recommended protein concentration varies depending on protein mass: 

o Scattering is proportional to mass 
o Larger proteins require less sample than smaller proteins. 
o Typical range  5 – 500 µg/injection 

§ BSA (67 KDa) 100 µl at 2 mg/ml  always gives a good light scattering signal 
• Sample volume:  

o Maximum injection volume:  100 µl 
o Minimum injection volume: 5 µl 
o Glass autosampler vial with low volume insert has 10 µl dead volume. Fill vial with at 

least 110 µl for a 100 µl injection. 
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 Getting Started 
 
Resources 
Additional resources are available at the instrument, including instrument and software manuals. 
 
Experimental Design Tips 

• The mass calculated from MALS is the weight-averaged molar mass and in a polydisperse 
sample, is shifted toward the mass of higher mass particles in the mixture. 

• Even if you cannot see peaks at the void in the UV signal, there will almost always be some 
soluble aggregates in your sample that will be in the void peak.  

• Choose a column such that your major peak of interest is in the center of the column, neither 
near the void peak nor near the solvent peak. 

o Any overlap between your peak of interest and the void peak will be hard to interpret, 
due to contributions to the weight-averaged mass from scattering of aggregates. 

o A solvent peak will be visible in the refractive index signal due to mismatch (even minor) 
between the running buffer and the sample buffer. If using RI as the concentration 
source, the solvent peak must be baseline resolved from sample peaks. 

General Care and Maintenance 
 

• Treat the SEC columns and chromatography system with care. 
o Avoid rapid pressure changes when a column is attached by changing flow rates 

gradually (using a maximum flow gradient to 0.1 ml/min2). 
o Always filter or centrifuge samples before loading. 
o Only load well-behaved protein samples. 
o Use filtered buffer with at least 100 mM salt and a pH appropriate to the column. 

• Store columns and system in water with 0.02% NaN3 when not in use. 
• Follow recommended start-up and shut-down sequences. 
• Open RI detector Purge valve to wash out the reference cell. 
• Run Comet to clean MALS after each run. 

 
Startup 
1. Book time on the PPMS calendar before you start. 
2. Login to the computer using your PPMS credentials (eCommons ID and password). 
3. The Agilent chromatography system will usually be on, but if not, then: 

a. Turn on the pump. 
b. Turn on everything else. 

4. Establish Connection to HPLC: 
a. Right-click the Wyatt Technology HPLC Service icon on the Windows Task Bar (bottom right). 
b. Select Connect HPLC. 

5. Open Astra 7 software. 
6. Go to Systems → HPLC Manager. 



   CMI Getting Started Guide  
 

CMI • Harvard Medical School • cmi.hms.harvard.edu • Kelly Arnett, PhD, Director  5 

Center for  
Macromolecular  
Interactions 
 
 7. On the tray above the pump, replace Storage buffer (0.02% NaN3 in Water) with a running buffer 

compatible with the column and your sample. 
8. Purge the Pump (whenever changing buffers). 

a. Open the purge valve on the Agilent Infinity 1260 isocratic pump. 
b. Set the maximum flow gradient to 100 ml/min2 (double check that the purge valve is open). 
c. Set the flow rate to 5 ml/min. 
d. Run at least 25 ml buffer through degasser and pump (5 min). 
e. Set flow to 0 ml/min. 
f. Set maximum flow gradient to 0.1ml/min2. 
g. Close the purge valve. 

9. Attach a new column: 
a. Remove the spacer connecting the inlet and outlet tubing in the column compartment. 
b. Remove column endcaps. 
c. Observe the column flow direction for the column you are attaching. 
d. Attach the inlet tubing to the top of the column using a wet connection. 
e. Attach the outlet tubing to the bottom of the column. 

10. Equilibrate the column with at least 8-12 column volumes of buffer. 
a. Choose a flow rate compatible with your column and equilibrate. 

i) For shared CMI columns and similar 7.8 x 300 mm silica columns:  
(1) Recommended: 0.5 ml/min overnight 
(2) For minimal buffer consumption: 0.1-0.2 ml/min overnight or 4+ hours at 0.5 ml/min. 

b. On the RI detector, the purge valve should be "ON," indicating that the valve is open and the 
reference cell is being equilibrated. 

c. On the MALS detector, run Comet for 10 min (System tab).  
11. After equilibration, adjust the flow to final flow rate, if necessary. 

a. A typical flow rate of 0.5 ml/min for shared 7.8 x 300 mm columns  
i) adjust as necessary to avoid exceeding the maximum pressure for the column. 

b. Wait until MALS and RI signals are stable. 
12. Check system readiness and prepare for data collection. 

a. Turn on the Heleos (light scattering detector) laser and Optilab T-rEx (RI detector) LED and allow 
signal to stabilize (1-5 min). 

b. Check that MALS detector 11 voltage signal is stable ~0.02-0.03 V, with noise ~10-4 V. 
c. Record the absolute refractive index (aRI) for your solvent. 
d. Close the RI detector purge valve (purge = "OFF") and zero the baseline. 
e. Check that the RI signal is stable with drift < 5x10-8/min. 

13. Prepare a filtered BSA sample at 2 mg/ml (110+ µl) to run as a control. 
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 Data Collection 
 

• A control dataset should be collected each time you use the SEC-MALS system, to test the 
system and to normalize and align detectors. 

o Control should be collected for each combination of column, buffer and flow rate. 
o Control should be well-behaved, monodisperse, and small (relative to the wavelength). 

§ BSA, 100 µl at 2 mg/ml, is most common. 
o The control dataset should be collected and processed first, in order to create a custom 

method (with custom normalization), that can then be used for sample data collection. 

Data Collection Steps 

1. Run BSA Control. 
2. Analyze BSA Control with Normalization and Alignment. 
3. Save Custom Method. 
4. Run user samples using Custom Method template. 
5. Analyze user samples (NEVER using Normalization or Alignment). 

Data Collection with HPLC Manager 
1. Prepare your sample(s) and load the autosampler.  

a. The first sample will typically be a control sample (e.g. BSA). 
b. All samples should be filtered or centrifuged for 10 min at max speed. 
c. Fill glass vial with low-volume glass insert with desired injection volume + 10 μl dead volume. 

Add a septum cap.  
d. Place sample(s) in the correct vial position in the autosampler (typically position 1 in the 

autosampler). 
2. Open ASTRA 7 software for MALS data collection. 
3. All Data can be collected from a Method or from a Sequence.  The first control sample is typically 

collected from a Method and user samples (especially multiple user samples) are typically collected 
from a Sequence. 

 
4. Data Collection from Method 

a. Open a MALS method: 
i) File → New → Experiment from Method. 
ii) Choose any recently saved method. (Older methods may have out-of-date calibration 

constants or processing parameters). 
(1) There should be a default method that will have the most recent calibration constants. 

iii) Review saved methods to be sure they are correct. 
b. Expand Configuration menu. 
c. Open HPLC Device (HPLC Pump), by double-clicking. 

i) Set the flow rate (e.g. 0.5 ml/min). 
ii) Set the maximum flow gradient to 0.1 ml/min2. 
iii) Set the high pressure limit for the column you are using. 

d. Expand HPLC Device (HPLC Pump). 
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 i) Click solvent and select best match to solvent (usually PBS) or create a solvent profile. 

e. Open  HPLC Device (HPLC Samper), by double-clicking. 
i) Select Injection mode: Standard or with Needlewash. 
ii) (Optional) Set Needlewash position (e.g. Vial 100). 

f. Expand HPLC Device (HPLC Samper). 
i) Enter sample name. 
ii) dn/dc: 0.185 (for protein). 
iii) UV extinction coefficient in ml/mg•cm. 
iv) Concentration of sample in mg/ml. 

g. Open HPLC Device (HPLC UV), by double-clicking. 
i) Set UV wavelength (e.g. 280 nm for proteins). 

h. Expand Procedures. 
i. Open Basic Collection, by double clicking. 

i) Set duration. 
ii) Set HPLC details: 

(1) Vial Number:  1-100. 
(2) Injection Volume (µl): 5-100.   

j. Save File. 
k. Confirm that the system is fully equilibrated. 
l. Click the Run button to begin data collection. 

i) DO NOT click on Run Default. 
m. The software will wait for the autosampler signal and then start collecting data. 

5. Proceed to Data Analysis and analyze BSA control data (with alignment and normalization). 
6. Save Custom Method using BSA alignment and normalization settings. 
7. To run additional samples, proceed to Data Collection from Sequence, below. Alternatively you 

may repeat as above, collecting sample data from Method, one sample at a time. 
 
8. Sample Data Collection from Sequence  

a. File → New →Blank Sequence 
b. Configuration 

i) Select the Method (the method you saved from the BSA after normalization, for example) 
ii) Enter the number of Samples 

c. Samples 
i) In the Vial Field, enter the vial number for each sample (can use “1” or “Vial 1”, etc) 
ii) In the Name Field, enter a short unique name for each sample. 
iii) Change extinction coefficient and any other default parameters for each sample 

d. Save the sequence. It is recommended to include the date and column name/description in the 
sequence name (e.g. 20210420_SepaxSEC300). This will be appended to the sample name to 
create a file name for each sample. 

9. After completing experiment, the chromatography system will still be running at the experimental 
flow rate. 

10. Proceed to the Shutdown to start re-equilibrating the column to Storage buffer. 
11. Data analysis can be performed off instrument, or while the column is re-equilibrating. 
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 Data Analysis 
 
1. Data analysis is performed within the Astra file. 

a. Data collected as a single experiment will still be open at the end of data collection. 
b. Data collected in a sequence will need to be opened in Astra before analysis. 

2. Parameters 
a. Basic Collection 

i) Examine the peaks. 
ii) Check the noise in the light scattering detectors (especially low angle detectors LS2-4). 

b. Despiking 
i) Check the despiking and change despiking level if needed (Normal despiking is usually fine). 
ii) Click ok if you make changes. 

c. Baselines 
i) Check the baseline for each detector. 
ii) Use auto-baseline calculation or modify baseline manually as necessary for each detector.  
iii) Running a few minutes past the solvent peak on the RI detector with simplify the baseline 

calls. 
iv) Click ok. 

d. Peaks 
i) Delete any existing peaks that were saved with the method. 
ii) Create peaks by dragging across the peak area. 
iii) Click ok. 

e. Molar Mass and Radius from LS 
i) Expand the enabled detectors folder. 
ii) Deselect detectors that are not contributing light scattering signal. 
iii) Click ok. 

3. Examine data. 
a. Examine peak calls and Molar Mass calculations in graph, modify peak calls as necessary. 
b. Examine results in the EASI graph and EASI table. 
c. For user samples, proceed to Save and Export Results (below). 
d. For control samples only, go to Normalization, Alignment and Band Broadening (next page). 

4. Save and Export Results. 
a. Save data. 
b. Export graphs. 

i) Right-click on any graph. 
ii) Click Edit → Export. 
iii) Choose export parameters. 
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For Control Only: Normalization, Alignment, and Band Broadening  

These procedures should only be performed using a small monodisperse control (e.g. BSA) 
DO NOT use your protein for these procedures. 
Should be performed once for each combination of column, buffer, and flowrate. 

c. Alignment (Align Detector signals)  
i) Right-click Configuration. 
ii) Select alignment. 
iii) Highlight peak (e.g. BSA monomer peak). 
iv) Click Align Signals button (top-left). 
v) Click ok (bottom-left) to apply and close the window. 

d. Band Broadening (Correct for broadening due to diffusion) 
i) Right-click Configuration. 
ii) Select Band Broadening. 
iii) Reset the broading terms in the table at the bottom. 
iv) Select the region in the center of the peak (not the entire peak). 
v) Click Perform Fit (top-left). 
vi) Click ok (bottom-left) to apply and close the window. 

e. Normalization (Normalize detectors) 
i) Right-click Configuration. 
ii) Select Normalize. 
iii) Chose which peak to use for normalization (default peak 1). 
iv) Click Normalize (or import from another file). 
v) Software will prompt peak selection if none have been selected 
vi) Click ok (bottom-left) to apply and close the window. 

 
 
Shutdown 
 
1. After completing experiments, the chromatography system will still be running at the flow rate of 

your experiment. 
2. Re-equilibrate the column with Storage buffer. 

a. Turn off the MALS laser and RI LED. 
b. Go to HPLC manager. 
c. Decrease flow rate gradually to 0 ml/min (use max. flow gradient of 0.1 ml/min2). 
d. Purge the Pump: 

i) Change the solvent to Storage buffer (Filtered water with 0.02 % NaN3) 
ii) Open the purge valve on the Agilent Infinity 1260 isocratic pump. 
iii) Set the maximum flow gradient to 100 ml/min2. 
iv) Set the flow rate to 5 ml/min. 
v) Run at least 25 ml buffer through degasser and pump (5 min). 
vi) Set flow to 0 ml/min. 
vii) Set maximum flow gradient to 0.1ml/min2.   
viii) Close the purge valve on the Agilent pump. 
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 3. Equilibrate column in Storage buffer: 

a. Set equilibration flow rate (0.5 ml/min for most shared columns). 
b. Run Comet on the MALS detector during equilibration. 

i) On the MALS detector LCD screen, go to the System tab. 
ii) Set Comet to run for 60 min. 

c. Purge the RI detector. 
i) Turn Purge "ON" on the RI detector LCD screen to open the reference cell so it is washed 

during equilibration. 
ii) Leave the purge valve ON at all times, except during data collection. 

d. Equilibrate shared columns for at least 2 column volumes (60+ minutes).  
4. Remove column: 

a. Ramp to 0.1 ml/min (using maximum flow gradient of 0.1 ml/min2).  
b. Remove column and replace with spacer.   
c. Cap the column ends and return shared column to storage drawer. 
d. Ramp to 0.0 ml/min (using maximum flow gradient of 0.1 ml/min2). 

5. Quit Astra Software. 
6. Empty the waste! 
7. Review the checklist and fill in the paper logsheet. 
8. Logoff from PPMS!   
 
Data Management 
Technology Size Exclusion Chromatography with Multi-Angle Light Scattering (SEC-

MALS) 
Instrument Agilent 1260 Infinity LC System with variable UV detector, Wyatt Dawn 

Heleos II MALS detector, Wyatt Optilab T-rEX Refractive Index Detector  
Recommended Repository Generalist Repository 

    

Software Type Data Collection & Analysis 

Current Version Astra, Version 7.3.2.21 

Data Files (Type, ~size) experiment file .afe7 3-5 MB/measurement 

Readable Exports basic collection .csv 4 MB/measurement 
 

report .pdf 300-350 KB/measurement 
 

easi graph .csv 5 MB/experiment 
 

easi table .csv 3-5 KB/experiment 

 
Book time and Report Problems through the PPMS system:  https://ppms.us/hms-cmi 

• rates are based on booked and real-time usage. 
 
Contact cmi@hms.harvard.edu with questions. 
 
last edited: 2023-05-12  


